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 Installation Instructions – CD1 + 
CD-1 Ignition System - Capacitive Discharge 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. NOT LEGAL FOR SALE 
OR USE IN CALIFORNIA OR ON ANY POLLUTION CONTROLLED VEHICLES. 

 

OVERVIEW ***software is optional 

The CD-1 capacitive discharge digital ignition system is intended for professional racing applications.  Both the CD-1 
ignition Module P/N 102001 and CD-1 Ignition Coil P/N 102002 is included in kit part number: 102003. 

•  Compatible with 4-6-8 cylinder race engines that utilize a distributor type ignition. Note: Not compatible with odd firing 

V6 engines.  

•  Works with most popular magnetic pickup distributors, magnetic crank triggers, points, Ford TFI or ECM.  

•  135 mJ spark energy output – Compatible with 16v Battery Systems – Operating Voltage 8.0v-20.0v DC 

•  Reverse polarity protection  

•  Mode switch allows you to easily adjust your ignition to match the number of cylinders in your engine 4-6-8. 

•  Triple RPM Limiter - Launch, Burnout, and Maximum RPM limits are adjustable in 100 RPM steps from 3,000 to 9,900 

RPM (10,900 RPM for maximum RPM limit). Our RPM limiters are accurate and smooth. 

•  User Configurable - Up to 10 degrees of Starting Spark Retard and Multi-Spark Enable/Disable (below 3000rpm) 

•  Optional - Ignition advance is fully programmable – Utilize our CD-1 PC-Link Software and USB Interface to access and 

re-map your ignition advance.  Choose from a simple RPM based advance curve to a 3D timing map with boost 
proportional retard. 

•  Built-in data logging - Stores 5 hours of data at 10 samples/sec or 30 minutes of data at 100 samples/sec. 

•  Dedicated input for Launch RPM Limiter and optional manifold pressure sensor (MAP).  

•  Optional – General Purpose Inputs(3) and Outputs(2).  The Inputs and outputs are configured via the USB Interface and 

CD-1 PC-Link Software.  The inputs can be programmed for: High Gear Timing Retard, Burnout RPM Limit, Adjustable 
Timing Retard, Vehicle Speed, and/or Throttle Position Sensor. Outputs can be programmed for: RPM window switch 
for Nitrous System Activation, and/or Multi-Gear Shift Light Functions. 

•  Fully encapsulated construction, waterproof 12 pin connector is utilized for external signal connections.                                      

•  Compact size. Module is 9.25”L x 3.625”W x 2.75”H. Coil is 4.4”L x 3.2”W x 3.0”H.         

•  Highly efficient switching power supply less than 5 amps of current draw at 12v DC and 8,000 RPM. 

 

  

               Optional 

CD-1 Ignition - 102001 CD-1 Ignition Coil - 102002   RTD-1 Retard Control - 102005 

http://www.daytona-twintec.com/
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ADDITIONAL INFO  

•  The parts bag supplied with the CD-1 includes a wire harness that plugs into the 12 pin connector, ring terminals 
for power and ignition coil connections, diodes and a set of Weather Pack connectors for tach and PC link hookup. 
To complete the installation, some applications may require additional wire, crimp terminals, fuses, switches, and 
relays. The Appendix includes a list of recommended parts and suppliers. 

•  USB interface P/N 102004 is required to utilize our free CD-1 Configuration Software OR Data Logging Software.  
The configuration and datalogging software are two different programs, and available via two different self-installing 
downloads.  A separate self-installing download is available for the USB interface driver.  All of these programs are 
compatible with most Windows Operating Systems from XP through Windows 11.  Before you run the installer on a 
Windows 11 or 10 machine, please disable One Drive.  If One Drive is enabled during the install, a conflict occurs 
and the program configuration file will not be installed in the correct folder.  

•  To utilize driver adjustable timing retard or boost proportional retard, you must purchase, install and configure the 
optional RTD-1 retard control P/N 102005. To utilize boost proportional timing, use our MAP sensor harness kit P/N 
102006 to connect our Delphi style MAP sensor. We offer three version of MAP sensors (1 Bar 115011, 2 Bar 
115012 and 3 Bar 115013). 

•  If your application utilizes the optional throttle position sensor (TPS) and/or vehicle speed sensor (VSS) signal 
connections. You will need to refer to the vehicle diagram for your vehicle to locate these connections.  

•  POWER CYCLE the ignition AFTER adjusting the switches or PRIOR to connecting to the USB Interface. If you 
do not power cycle the ignition prior to connecting the USB – the software will not communicate with the ignition.  
After making changes to the front switch settings – power cycle the ignition so the switch changes will take effect. 

•  If you will be using the configuration or data log software, we recommend that you use the included single pin M/F 
connectors to connect the tach.  When needed, the USB connects in place of the TACH.  The USB connection can 
only functions after a power cycle – once you try to start the engine it defaults to TACH output. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

STATUS LED    Figure 1A 

WHAT IS IN THE BOX  -  Figure 1  

 

CD-1 Ignition Coil – 102002 

 

 

CD-1 Ignition - 102001 

Instructions 

Wire Harness 

Power/Ground Terminals 

Coil Terminals 

Connectors for Tach 

Diodes for connecting 
INPUTS directly to solenoid 
type coils (line-loc and trans-
brake – see wiring diagrams)    

http://www.daytona-twintec.com/
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Status LED 

Solid Status LED -- illuminates when powered on after a 
power cycle. 

Blinking Status LED – engine running and it turns off – but 
the ignition has not been turned off -- it is normal for this to 
occur if the engine starts and shuts off. This can also occur 
if you have a bad magnetic trigger module or intermittent 
or poor trigger wiring [loss of trigger signal. 

Blinking Status LED after power on – internal fault 

MODE - Switch Settings      Figure 1B 

 

Mode Switch Settings 

   0   --   8 cylinder engine and normal operation 

   1   --   6 cylinder engine and normal operation 

   2   --   4 cylinder engine and normal operation 

   3   --   8 cylinder engine and boost timing retard mode with 2 bar 
MAP sensor 

   4   --   6 cylinder engine and boost timing retard mode with 2 bar 
MAP sensor 

   5   --   4 cylinder engine and boost timing retard mode with 2 bar 
MAP sensor 

   6   --   8 cylinder engine and boost timing retard mode with 3 bar 
MAP sensor 

   7   --   6 cylinder engine and boost timing retard mode with 3 bar 
MAP sensor 

   8   --   4 cylinder engine and boost timing retard mode with 3 bar 
MAP sensor 

   9   --   Reserved (not used) 

MAX RPM - Switch Settings 
Figure 1C 

 

 

 

Maximum RPM Limit - Switch Settings 

The maximum RPM limit setting is offset by +1,000 RPM. 
This allows the two switches to set the MAX RPM value 
between 1,000 and 10,900 RPM 

Examples:  Switch Setting 10 = 2000 RPM , Switch Setting 
75 = 7,600 RPM, Switch Setting 99 = 10,900 RPM  

 

00-99 Maximum RPM limit setting X100 + 1000 

 

 

Launch RPM - Switch Settings 
Figure 1D 

http://www.daytona-twintec.com/
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Launch RPM Limit - Switch Settings 

Launch RPM Limit functions if the switches are set 
between 06 (600rpm) and 99 (9,900 rpm). 

Settings 00 – 02 are typically used for user testing. 

NOTE: These two switches can perform several functions. 

 

00 RPM limit disabled  (no RPM limit) 

01 RPM limit and multi-spark disabled 

02 RPM limit, multi-spark, and user defined timing 
functions disabled 

03-05 Do Not Set (factory testing only)  

06-99 Launch RPM limit setting X100 (i.e. switch setting 
66 = 6,600 RPM) 

 
 

GENERAL USAGE INFORMATION 

 

•  If you have a locked-out distributor (fixed timing) and wish to fire the engine at a fixed time.   
After installing the ignition, follow the steps listed below: 
  1 – Use a TCD tool to Verify Top Dead Center (0) on your balancer matches your timing pointer for Cylinder 1 
– Note: when rotating the engine air will begin to blow out of CYL 1 when your on the correct cycle. 
  2 – Remove the TDC Tool - Rotate the Engine to the desired timing on CYL1 – almost any petrol engine will 
start and run if you use 20 degree BTDC (Before Top Dead Center) for the initial timing.  
  3 – Install the distributor so the rotor is pointing at the terminal for CYL 1 (Note: For high-rpm use - rotor 
phasing is very critical – and outside of the scope of this document). 
  4 – Reinstall the spark plug and wire for CYL 1 – Crank the engine and adjust the total timing as desired. 
 

•  If you have a distributor with either mechanical or vacuum advance (points or magnetic) or Ford TFI 
Follow the above procedure with one change – the “base/initial” timing is typically set between 6-14 degrees.  If 
your distributor has advance built into it – typically you would not build or utilize a custom timing table.   
 

•  Looking to build your own custom timing curve? 
We recommend using a locked-out distributor and/or racing crank trigger and fixed timing. 
The CD-1 Configuration Software and USB interface allows you to build your own custom timing curve. 
The total timing range of the CD-1 is limited to 22 degrees to prevent possible cross-firing into the next 
cylinder. Example, if you set trigger timing to 32 degrees, the actual advance range is 10.0 to 32 degrees. 
 

•  Using nitrous oxide or a supercharger/turbocharger? 
Utilize the USB interface and CD-1 Configuration Software to access the optional functions to setup timing 
retard based on nitrous activation and/or boost (Map sensor and RTD-1). 
 

•  The CD-1 ignition is setup from the factory to retard the timing 10 degrees when cranking. 
The timing retard is active when the ignition box is powered on and the engine RPM is less than 150 RPM. 
The amount of cranking retard is user adjustable via the USB interface and the CD-1 Configuration Software. 

 

WIRING OVERVIEW 

http://www.daytona-twintec.com/
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Power Connections – Heavy Gauge Power Wires 

Heavy RED 
(12 AWG) 

Battery+  Connects to battery positive terminal. Do not connect directly 
to the alternator (if equipped). Extend with same wire gauge. 

Heavy BLACK 
(12 AWG) 

Ground Connects to chassis ground - battery negative terminal (-) or 
at the engine – a clean, secure ground connection is 
required 

Ignition Coil Primary Connections – Note: DO NOT use a ballast resistor 

Orange Coil+ Connects to coil positive terminal – No other wires connect 

Black Coil- Connects to coil negative terminal – No other wires connect 

12 PIN Connector Signals – 18 gauge wires 

Pin 1 – Red Ignition 
Switch 

Connects to a switched +12v ignition switch – Turns the unit 
on and off. 

Pin 2 – Blue Launch RPM 
Limit 

Input Connects to Launch RPM limit circuit. Supplied 1N4007 
diode must be installed if circuit includes a solenoid valve. 

Pin 3 –Orange GPI1 General purpose input 1 – User defined via software. Can 
also be used as the input for RTD-1 retard command signal. 

Pin 4 - Grey GPIO2 General purpose input/output 2 – User defined via software - 
Used for burnout RPM limit. Supplied 1N4007 diode must be 
installed if circuit includes a solenoid valve. 

Pin 5 - Yellow GPIO3 General purpose input/output 3 – User defined via software 

Pin 6 - Violet Magnetic 
Trigger+ 

Input - Connects to magnetic pickup distributor or crank 
trigger. If the magnetic trigger inputs are used, the module 
trigger input on pin 12 must be left open.  

Pin 7 - Green Magnetic 
Trigger- 

Input - Connects to magnetic pickup distributor or crank 
trigger. If the magnetic trigger inputs are used, the module 
trigger input on pin 12 must be left open. 

Pin 8 - Blk/White Sensor 
Ground 

Optional - Connects to MAP sensor and RTD-1 ground  

Pin 9 Green/White MAP Sensor Optional - Connects to 0-5V MAP sensor signal 

Pin 10 Red/White +5V Power Optional - Connects to MAP sensor and RTD-1 power 

Pin 11 - Brown Tach/RS-232 Output - Connects to Tach OR optional USB interface  

To connect the USB interface, Tach must be disconnected 

Pin 12 - White Module 
Trigger 

Input - Connects to trigger output from points or Ford TFI or 
engine control module. If the module trigger input is used, 
the magnetic trigger inputs on pins 6 and 7 must be left 
open. 

http://www.daytona-twintec.com/
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Figure 2 – Basic Magnetic Trigger Hookup – NOTE: Trigger input must not be used in this config  

 
  

http://www.daytona-twintec.com/
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Figure 3 – Basic Module Trigger Hookup – NOTE: Mag Trigger must not be used in this config  

 

 

 

http://www.daytona-twintec.com/
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CD-1 – BASIC -- INSTALLATION 
1. Turn off the ignition switch and disconnect the battery ground cable before proceeding. 

2. Select a convenient mounting location for the CD-1 module and coil. The CD-1 module is fully 
encapsulated and waterproof, but it should be mounted in a dry location away from sources of heat. 
Orient the unit so that you will have easy access to the rotary switches. The CD-1 coil can be mounted in 
the engine compartment near the distributor.  

3. Refer to Figures 2 or 3 for basic hookup.   

4. Power connections.  

+12v - Connect the HEAVY Gauge RED 12 AWG 
wire directly to the +12v battery terminal or to a 
battery disconnect switch or to the battery feed terminal of the remote starter solenoid. If the battery is 
mounted in the trunk, we recommend a min 12 AWG wire be used from the ignition to the power source.  

Ground - Connect the HEAVY Gauge BLACK 12 AWG wire directly to the negative battery terminal or 
chassis ground near the engine, preferably where the battery ground cable is attached. Verify that the 
engine is properly grounded to the chassis. Separate grounds are recommended for each cylinder head.  

In the rare case that the +12v wire is an extreme distance from the ignition OR you are having issues with 
ignition noise - you can use a 10000 UF 25V electrolytic capacitor such as our P/N 102007 capacitor kit or 
Mouser (www.mouser.com) P/N 539-CGS103U025RC3 and bracket P/N 539-VR3A as shown in figure 2/3.  

5. Ignition switch connection. Connect the thin red wire from the 12-pin connector (pin 1) to the ignition 
switch or +12v power switch as shown in figure 2/3. The ignition powers ON when +12v is applied to the 
thin red wire - pin 1. 

6. Ignition Trigger Signal connection.  

Choose either Magnetic Pickup or Module Trigger. Note: Only one input type can be used at a time – be 
sure to tape up the unused input. 

Magnetic Pickup - The violet/green magnetic pickup 
cable is supplied with an AMP connector that will 
mate with many common magnetic pickup distributors 
and crank trigger systems (Msd). For other magnetic 
pickups, cut off the connector and refer to the color 
code table below.  

Module Trigger – Input is usually connected to: 
Points or Points Replacement module, Ford TFI or 
engine control modules such as Haltech or Motec. 
The module trigger input requires a        0-12V square 
wave signal and fires on the rising edge. The module 
trigger input on pin 12 is tolerant of high voltage 
pulses and has an internal 150-ohm pull-up resistor to 
+12V. 

 

 

7. Coil connections. Connect the black and orange coil wires to the ignition coil as shown in figure 2/3. 

Typical - Magnetic Trigger Color Codes 

System Mag- Mag+ 

Accel/Chrysler 
Distributor 

Black Orange/White 

Accel Crank 
Trigger 

Black White 

Moroso Crank 
Trigger 

White Black 

MSD Crank 
Trigger 

Green/Black Violet/Orange 

MSD/Ford 
Distributor 

Violet Orange 

GM Distributor Green White 

WARNING: Do not cut the power or coil 
wires shorter than 12 inches. Doing so 
makes the unit difficult to factory test 
and will void the warranty. 

http://www.daytona-twintec.com/
http://www.mouser.com/
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Orange – Coil + terminal    Black – Coil - terminal  

8. Tachometer connection. Use the supplied M/F 
Weather Pack connectors as shown in Figures 2-3 
to connect the brown wire from 12 pin connector 
pin 11 to the vehicle tachometer as shown. When 
the engine is running the industry standard 0-12V 
square wave signal appears on the tach output with one tachometer pulse per trigger event. The rising 
edge of tach pulse is synchronized with the trigger event. Our tach output is compatible with all 
aftermarket tachometers, and can be used to trigger other RPM activated accessories. 

Optional - The tachometer output wire is also used by the USB interface P/N 102004 to communicate with 
configuration and data log software. To use the USB interface, connect the USB interface, power the 
ignition on and DO NOT start the engine and connect to the ignition.  

9. Optional - Application specific signal connections (Inputs and Outputs) Launch, GPI1 and GPIO2/3, 
MAP and 5v power – be sure to tape off or utilize heat shrink on unused connections.  Refer to Figures 4-
10. 

10.  Completing the installation. Set the CD-1 switches and upload or change software configuration 
options (optional). 

Reconnect the battery. 

Start engine and check timing. If the engine was already running prior to installation and the timing has 
changed significantly, MAG+ and MAG- may be reversed (if connected).  When connected correctly the 
timing will be at the most retarded – if connected incorrectly (timing will be more advanced than normal). 

 
Figure 4 – Optional -- RTD-1 Retard Control and MAP Sensor Hookup  

 

Figure 5 – Optional -- Automatic Transmission RPM Limit Switch Hookup (Launch / Burnout) 

DANGER 
 High voltage is present at the ignition 
coil – ORANGE / BLACK Wires and 
terminal when the ignition switch is on.  
 

http://www.daytona-twintec.com/
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Figure 6 – Optional - Manual Transmission RPM Limit Switch Hookup (Launch / Burnout) 

 

http://www.daytona-twintec.com/
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Figure 7 – Optional - Nitrous Oxide System Hookup 

 

Figure 8 – Optional - Additional GPI1 Hookup Options 

 

http://www.daytona-twintec.com/
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Figure 9 – Optional - Additional GPIO2 Hookup Options 

 

Figure 10 – Optional - GPIO3 Hookup Options 

 

http://www.daytona-twintec.com/
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Optional – Boost Retard - MAP Sensor and RTD-1 Retard Control Hookup 

Installation of a 2 or 3 bar MAP sensor AND the RTD-1 timing retard control is required for boost timing retard 
(Figure 4). 

Configure the “Mode Switch” on the front panel to match your engine/map setup (Figure 1B). 

After installing the MAP sensor and RTD-1 utilize your PC and PC Link CD-1 Configuration software to 
connect via the USB interface to the ignition, setup the feature and create a boost timing retard table. 

1. RTD-1 retard control. The RTD-1 unit is not waterproof and is intended for under dash mounting only. 
Connect the ground, retard command, and +5V power wires as shown in Figure 4. 

2.  MAP sensor. The optional MAP sensor harness includes mating connector shells for Delphi 1 bar, 2 bar, 
and 3 bar MAP sensors (refer to the Appendix for recommended MAP sensor part numbers). Select the 
connector shell with the appropriate indexing features for your MAP sensor. Connect the ground, MAP 
signal, and +5V power wires as shown in Figure 4. If you are using the RTD-1 and MAP sensor together, 
splice the ground and +5V power wires from the MAP sensor to the same wires from the RTD-1 near the 
CD-1.   

Optional - Automatic Transmission RPM 
Limit Switch Hookup (Launch / Burnout) 

Figure 5 shows typical hookup of the line lock and trans 
brake solenoid valves for automatic transmission 
vehicles.  

1. Trans brake and Launch RPM Limit - Figure 5 - 
The trans brake input is active before launching and is used to select the launch RPM Limit set on the CD-
1 font panel switches (Figure 1D). The Launch RPM Limit is selected when +12V is applied to Pin 2 
(Blue). 

2. Line lock and Burnout RPM Limit - Skip ahead if this feature is not used. The line lock is active during 
burnout and selects the Burnout RPM Limit. IMPORTANT - GPIO2 must be programmed for Burnout 
RPM Limit Mode. Utilize the USB interface and PC Link CD-1 Configuration software to enable this 
feature and setup the RPM.  Burnout RPM Limit is selected when +12v is applied to Pin 4 (GPIO2) and 
the feature is setup.  

Optional - Manual Transmission RPM 
Limit Switch Hookup (Launch / Burnout) 

Figure 6 shows typical hookup of the line lock and 
burnout RPM limit switch for manual transmission 
vehicles.  

3. Line lock and Launch RPM Limit - Figure 6 - The line lock is active before launching and used to select 
the launch RPM limit set on the CD-1 font panel switches (Figure 1D). The hookup shown in Figure 6 uses 
a relay to hold the line lock on until the clutch is released. A normally open momentary pushbutton switch 
is used to initially set the line lock. The clutch switch is normally open and closes when the clutch pedal is 
down. The Launch RPM Limit is selected when +12V is applied to Pin 2 (Blue). Alternatively – this can 
be wired without the Line Lock. 

1. Burnout RPM Limit. Skip ahead if this feature is not used. A user provided external switch is used to 
select the burnout RPM limit. GPIO2 must be configured for burnout RPM limit mode, utilize the USB 
interface and PC Link CD-1 Configuration software to enable this feature and setup the RPM. Burnout 
RPM Limit is selected when +12v is applied to Pin 4 – Grey (GPIO2) and the feature is setup  

WARNING: Failure to install the diodes 
shown in Figure 6 will damage the CD-1 
and void the warranty. 

WARNING: Failure to install the diode 
shown in Figure 5 will damage the CD-1 
and void the warranty. 

http://www.daytona-twintec.com/
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Optional - Nitrous Oxide System (NOS) Hookup 

Figure 7 shows typical hookup of the single stage NOS kit that is controlled by the CD-1. The NOS is triggered 
based on throttle position and an RPM window. When the NOS is triggered on, timing can be automatically 
retarded up to 10 degrees. The use this capability, GPI1 must be programmed for NOS enable mode and GPIO2 
must be programmed for NOS trigger mode by means of the PC link (refer to pages 18-19 for details). Either a wide 
open throttle switch or throttle position sensor can be used for NOS enable.  

1. Wide open throttle switch for NOS enable. The switch is normally open and closes at wide open throttle. 
This arrangement is typically used with carbureted vehicles. +12V for the wide open throttle switch is supplied 
by a separate NOS arming switch. +12V on GPI1 enables the NOS.  

2. Throttle position sensor (TPS) for NOS enable. Vehicles with electronic fuel injection typically have a TPS 
with 0-5V signal output. Refer to the vehicle wiring diagram for details. You can check the TPS signal with a 
DVM. The threshold TPS voltage for enabling the NOS is programmed by means of the PC link.  

3. NOS wiring. The arming switch should be connected to switched +12V so that the NOS cannot be armed 
when ignition power is off. A relay with a minimum 40 amp rating is required. If your nitrous system uses large 
solenoid valves, you should use the heavy duty P&B/Tyco VF7 series 70 amp relay listed in the Appendix. The 
use of a 50 amp fuse block such as the Littlefuse Maxi Fuse series listed in the Appendix is recommended. 
Power connections from the fuse block must go direct to the battery positive terminal or battery disconnect 
switch. The ground connection from the solenoids must go to a chassis ground stud or direct to the battery 
negative terminal. Use 12 or 14 AWG wire. Keep power and ground connections as short as possible.    

Additional GPI1 Hookup Options 

Figure 8 shows additional hookup options for GPI1 
modes that can be programmed by means of the PC 
link when the GPI1 input is not used by one of the 
configurations shown in Figures 4 or 7. Refer to page 
18 for programming details. 

1. Data log mode. This is the default for GPI1 if no 
other mode is programmed. Both 0-5V analog 
signal levels and 0-12V digital off/on values are 
simultaneously logged by the CD-1. The on 
threshold voltage for digital signals is approximately 2.5V and the input is tolerant of voltage levels up to 30V. 
Many automotive sensors have 0-5V signals levels and can be connected to GPI1. A +5V reference for sensor 
power (up to 50 ma current) is available at pin 10. To avoid errors caused by voltage drop between the CD-1 
and chassis ground, pin 8 can be used as the sensor ground. A switch or relay contact to +12V can be 
connected to GPI1 and logged as a digital signal.  

2. Digital retard mode. This can be used as a high gear retard or retard function for a nitrous system. Connect a 
switch or relay contact to +12V to GPI1. Timing is retarded up to 10 degrees when GPI1 is at +12V.  

Additional GPIO2 Hookup Options 

Figure 9 shows additional hookup options for GPIO2 modes that can be programmed by means of the PC link 
when the GPIO2 terminal is not used by one of the configurations shown in Figures 5-7. Refer to page 19 for 
programming details. 

1. Digital data log mode. This is the default for GPIO2 if no other mode is programmed. 0-12V digital off/on 
values are logged by the CD-1. The on threshold voltage for digital signals is approximately 2.5V and the input 
is tolerant of voltage levels up to 30V. A switch or relay contact to +12V can be connected to GPIO2 and 
logged as a digital signal.  

2. Vehicle speed input mode. In this mode, the CD-1 will log speed data from a Hall Effect type vehicle speed 
sensor (VSS) with 0-5V signal levels. Many newer vehicles already have an appropriate VSS signal that can be 
directly connected to GPIO2. Most vehicles manufactured since 1981 will have a VSS. Older vehicles will 
require installation of a driveshaft sensor (refer to the CD-1 Tech FAQ on our website for details).  

WARNING: If GPI1, GPIO2, or GPIO3 are 
used as a digital input and some 
inductive device such as a solenoid is 
also part of the circuit, a diode is 
required to protect the input from 
transients. Failure to install the 
required diode will damage the CD-1 
and void the warranty. 

http://www.daytona-twintec.com/
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3. RPM window switch mode. Connect a relay as 
shown to control a load. You can connect an 
optional arming switch as shown. For direct battery 
power connections, you should also install a fuse. 
Refer to the Appendix for recommended relays and 
fuses.  

GPIO3 Hookup Options 

Figure 10 shows hookup options for GPIO3 modes that 
can be programmed by means of the PC link. Refer to 
page 19 for programming details. 

1. Digital data log mode. This is the default for 
GPIO3 if no other mode is programmed. 0-12V 
digital off/on values are logged by the CD-1. The 
on threshold voltage for digital signals is 
approximately 2.5V and the input is tolerant of 
voltage levels up to 30V. A switch or relay contact 
to +12V can be connected to GPIO3 and logged as 
a digital signal.  

2. Shift light mode. Connect an LED shift light such 
as Autometer (www.autometer.com) P/N 5330 as 
shown. Maximum current draw should not exceed 
1 amp.     

3. RPM window switch mode. Connect a relay as 
shown to control a load. You can connect an 
optional arming switch as shown. For direct battery 
power connections, you should also install a fuse. 
Refer to the Appendix for recommended relays and 
fuses.  

SWITCH SETTINGS AND STATUS 
LED 

The left end panel of the CD-1 has five rotary 
switches used to set RPM limits and operating modes 
and a status LED. The status LED will illuminate when 
the ignition switch is turned on. If a fault condition 
occurs, such as a DC/DC converter (internal high 
voltage power supply used to charge the capacitor) 
fault or loss of trigger signal, the status LED will blink.  

Launch RPM Limit Switch Settings 

00 RPM limit disabled  

01 RPM limit and multi-spark disabled 

02 RPM limit, multi-spark, and timing functions 
disabled 

03-04 Reserved (not used) 

05 Boot load mode (used by factory to 
reprogram CD-1 module) 

06-99 Launch RPM limit setting X100 (i.e. switch 
setting 35 = 3,500 RPM) 

Maximum RPM Limit Switch Settings 

The maximum RPM limit setting is offset 1,000 
RPM to allow two switches to set the value between 
1,000 and 10,900 RPM 

00-99 Maximum RPM limit setting X100 + 1000 (i.e. 
switch setting 75 = 8,500 RPM and 99 = 
10,900 RPM) 

Mode Switch Settings 

0 8 cylinder engine and normal operation 

1 6 cylinder engine and normal operation 

2 4 cylinder engine and normal operation 

3 8 cylinder engine and boost timing retard 
mode with 2 bar MAP sensor 

4 6 cylinder engine and boost timing retard 
mode with 2 bar MAP sensor 

5 4 cylinder engine and boost timing retard 
mode with 2 bar MAP sensor 

6 8 cylinder engine and boost timing retard 
mode with 3 bar MAP sensor 

7 6 cylinder engine and boost timing retard 
mode with 3 bar MAP sensor 

8 4 cylinder engine and boost timing retard 
mode with 3 bar MAP sensor 

9 Reserved (not used) 

Mode switch settings 0-2 are used during normal 
operation of the CD-1 and allow full functionality of any 
selections made with the PC Link software.  

Boost timing retard (BTR) mode requires 
connection of a 2 bar or 3 bar MAP sensor and 
connection of the optional RTD-1 retard control to the 
GPI1 input (refer to Figure 4 and details on page 10). 
BTR mode allows easy setup of boost proportional 
retard without the use of the PC Link software to create 
a 3D timing table. The RTD-1 allows the user to dial in 
0-3 degrees/psi boost retard with a 2 bar MAP sensor 
or 0-1.5 degrees/psi boost retard with a 3 bar MAP 
sensor. Mode switch settings 3-8 for BTR mode 
override and disable any 2D or 3D timing table settings 
made with the PC Link software. When BTR mode is 
selected, the automatic start retard feature (if enabled) 
remains operational. BTR mode also overrides any 
selection made in the PC Link software for GPI1. The 
RTD-1 generates a zero to +5V analog signal on GPI1. 
This analog data is logged by the CD-1 and available 
for display with the CD Log software. Zero volts 
corresponds to zero boost retard and +5V corresponds 
to full scale boost retard.  

http://www.daytona-twintec.com/
http://www.autometer.com/
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Figure 11 – Switches and Status LED 

 

SPARK PLUGS AND WIRES 
To avoid electrical noise that may interfere with 

the CD-1 or other onboard computer and radio 
equipment, resistor spark plugs are recommended and 
spiral core RFI/EMI suppression type spark plug wires 
are required. Optimum spark plug gap is .045" for 
normally aspirated engines. Engines with high boost 
levels may require a smaller spark plug gap. Do not 
use solid copper or high resistance carbon core spark 
plug wires. Optimum spark plug wire resistance is 50-
500 ohms per foot, such as Taylor Vertex 
(www.taylorvertex.com) ThunderVolt 50 or 8.2mm 
spiral core.  

http://www.daytona-twintec.com/
http://www.taylorvertex.com/
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APPLICATION ISSUES WITH 
VINTAGE RACE VEHICLES 

Application issues may occur with vintage race 
vehicles, especially 1970s and earlier Ford, GM, and 
Mopar vehicles that have original equipment charging 
systems. General information is given below. For 
assistance with specific applications, please contact 
our tech support. 

1. Tach hookup. Some original equipment tachs 
require a high voltage pulse and will require a 
commercially available tach adapter. GM vehicles, 
including all models with HEI coil-in-cap, have an 
inline tach filter. Disconnect the filter, trace the wire 
from the tach, and connect it to the CD-1 as shown 
in Figures 1 or 2. 

2. Ignition run-on. If the engine continues to run 
after the ignition switch is turned off, current is 
leaking back into the CD-1 through the charging 
system indicator lamp. GM or Ford models with an 
external voltage regulator will require installation of 
a diode.  

3. Import vehicles with electronic fuel injection or 
a fuel pump cut-out relay. Some systems require 
a tach signal with a high voltage pulse and will 
require a commercially available tach adapter. 
Some Japanese vehicles using the module trigger 
hookup shown in Figure 2 will also require a tach 
adapter. 

TROUBLESHOOTING 
Did the engine run properly before installation of 

the CD-1? If not, remove the CD-1, reinstall the original 
ignition system and then find and correct the original 
problem. Did the CD-1 function correctly before the 
problem occurred? If the answer is yes, did you 
change anything that may have affected it? To isolate 
the problem, go back to the last setup that was OK. If 
the engine will not start, runs intermittently, or misfires, 
use the following check list steps: 

Status LED Doesn’t Illuminate 

If the status LED doesn't illuminate after the 
ignition switch is turned on, check power and ground 
connections. Use a volt meter to verify +12V at the 
battery+ and ignition switch wires at the CD-1 with the 
ignition switch in both the run and start positions. The 
CD-1 requires a minimum of +9V when the ignition 
switch is first turned on. During cranking, the unit will 
continue to operate down to +4.5V.  

 

Engine Will Not Start 

If the status LED illuminates when the ignition 
switch is turned on but the engine will not start, verify 
that the status LED blinks while the engine is cranking. 
If the status LED doesn't blink during cranking, the unit 
is not getting a trigger signal. Verify that trigger signal 
wiring is not shorted together or to ground. If the status 
LED blinks, but engine will not start, recheck coil 
primary connections or replace coil.  

Import vehicles: if the engine momentarily starts 
and then dies, a fuel pump cut-out relay may not be 
operating properly. Please contact our tech support. 

Spark Testing 

K-D Tools HEI ignition test plug P/N 2756 is 
recommended for spark testing. Attach the alligator clip 
on the test plug to chassis ground and fabricate a short 
section of spark plug wire to connect the test plug to 
the coil. 

Intermittent Operation or Misfire at High RPM 

1. Misfire at high RPM is usually not an electrical 
problem with the CD-1. Common causes include: 
coil failure or arcing at spark plug boots or within 
the distributor. 

2. For vehicles without an alternator, low battery 
voltage may cause misfire at high RPM. Verify that 
the battery is fully charged or try replacing the 
battery.  

3. To avoid electrical noise problems, route magnetic 
trigger wiring away from any coil or spark plug 
wires. Use only spiral core spark plug wires. Do not 
use solid copper core or carbon core resistance 
wires. 

4. Check for broken, loose or corroded connections. 
Verify correct air gap for magnetic pickup. Check 
distributor for loose, missing, or jammed parts in 
advance mechanism.  

5. Verify that spark plugs are proper type, gap size, 
and heat range. 

6. Replace spark plugs, spark plug wires, and 
distributor rotor and cap.  

http://www.daytona-twintec.com/
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CD-1 SOFTWARE OVERVIEW 
The  Windows software suite for the CD-1 

system consists of the PC Link CD and CD Log 
programs. PC Link CD allows you to set module 
parameters that control overall operation of the system 
and override certain switch settings, program the 
functions of the general purpose input/output (GPIO) 
terminals, and program advance curves. CD Log 
software allows you to download data from the CD-1 
module, open and save files to disk, display data on a 
chart, and print chart graphics. Chart display for 
downloaded data allows you to monitor vehicle 
operation on the track.  

Use of the software programs is optional and not 
required for basic operation of the CD-1 system. If you 
are not planning on using the software, you can skip 
the rest of the material in this instruction manual.  

PC REQUIREMENTS 
The CD-1 connects to your PC by means of an 

optional USB interface P/N 102004. The PC must have 
a free USB port. If you have an older PC without USB 
capability, you cannot use the CD-1 software.  

We recommend a laptop PC with Pentium 
processor and super VGA display (SVGA with 1024 x 
768 pixel resolution) running Windows XP/Vista/7. 
Data chart display is graphics intensive and a high 
speed Pentium processor is recommended. 
Processors slower than 300 MHz will exhibit sluggish 
program loading and response.  

PC Link CD and CD Log software include print 
commands to print downloaded data. The programs 
have been tested with Hewlett-Packard laser and inkjet 
printers and Epson inkjet printers. We recommend 
using a color inkjet printer. 

USB INSTALLATION 
The USB interface for the CD-1 is based on the 

FTDI FT232R chip and drivers that allow the unit to 
emulate a standard Windows RS-232 COM port. 
Updated Windows drivers, installation instructions and 
troubleshooting tips are available on the FTDI website 
at www.ftdichip.com.  Additional information and 
troubleshooting tips can be found on the PC Link Tech 
FAQ on our website at www.daytona-sensors.com.  

A new USB driver that simplifies the installation 
process is available. This installs as an executable file, 
similar to other Windows programs. The Windows 
Found New Hardware Wizard will then detect the USB 
device when it is first connected and automatically 
install the correct driver without the user having to 
browse out. 

Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's PC Link Tech FAQ for details. 

1. Make sure your USB interface is not connected to 
your PC. Please note that the USB interface does 
not need to be connected to the CD-1 during the 
USB installation process.   

2. From the Daytona Sensors website go to the 
software download library located under the Tech 
Center tab. Scroll down and click on the USB 
Driver link. When the File Download dialog box 
appears, click on "Run this program from its 
current location." Ignore any security warnings and 
click on Yes to continue.   

3. After installation of the driver is complete, connect 
the USB interface to the PC with the supplied USB 
cable. The Windows Found New Hardware Wizard 
will appear and complete installation of the USB 
interface.   

COM Port Configuration 

After completing the installation steps outlined 
above, you must configure the new COM port using 
Device Manager.  

1. Windows XP: click Start, Settings, Control Panel, 
System, Hardware, and then Device Manager. 
Windows Vista: click Start, Control Panel, System 
and Maintenance, and then Device Manager. 
Windows 7: Click Start, Control Panel, System 
and Security, and then Device Manager. For more 
information, visit www.pcsupport.about.com. 

2. Scroll down to Ports (COM and LPT). The new 
USB interface will appear as a USB Serial Port. 
Click on this new port. Click on the Port Settings 
tab. 

3. Click on Advanced. In most cases the wizard will 
have installed your new USB interface as COM5. 
Note the COM port number assigned for your 
system. For optimum performance, you should 
also change the BM Options Latency Timer to 2 
msec as shown in the Figure 12.  

4. Once you have configured a COM port number for 
your new unit, make sure that you use this same 
COM port selection in the CD-1 software by using 
the Port Setup command from the 
Communications menu. 

Figure 12 – COM Port Configuration 

http://www.daytona-twintec.com/
http://www.ftdichip.com/
http://www.daytona-sensors.com/
http://www.pcsupport.about.com/
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SOFTWARE INSTALLATION 
The software is supplied in the form of a 

compressed file downloaded from our website. The 
installation process uses InstallShield. This industry 
standard installer is based the new Microsoft Windows 
Installer service that greatly reduces potential problems 
such as version conflicts and allows for application 
self-repair.  

There are two programs to install: PC Link CD 
and CD Log. Start by installing PC Link CD. If you are 
downloading software from the web, only download and 
install one program at a time. Before proceeding with 
installation, shutdown any other applications that may be 
running. For Windows Vista, you must disable the User 
Account Control (UAC) during installation. If you are 
not familiar with the UAC, please refer to the Vista 
UAC Tech Note on our website's Tech FAQ for details.  

Use the Windows Explorer or the Run command 
from the Windows Start Menu to launch the setup.exe 
file downloaded from our website. InstallShield will install 
the software in an appropriate folder under Program 
Files. 

Repeat the installation process for CD Log. Use 
the Windows Explorer or the Run command from the 
Windows Start Menu to launch the setup.exe file 
downloaded from our website. InstallShield will install the 
software in an appropriate folder under Program Files. 

Once InstallShield has completed the 
installation, PC Link CD and CD Log will appear on the 
Windows Start Menu. You can then launch them just 
as you would any other Windows program.  

The programs require the Monospace 821 BT 
fixed pitch printer font in order to properly align 
columns when printing. The Monospace 821 BT font is 
included in the distribution media and automatically 
copied to your Windows Fonts folder during 
installation. A backup copy is also placed in the 

program folder. If you accidentally delete this font, use 
the Install New Font command from the Fonts folder 
File menu. The filename associated with Monospace 
821 BT is monos.ttf. 

PC LINK CD SOFTWARE 
The brown tachometer wire (Deutsch connector 

pin 11) from the CD-1 is used connect to the USB 
interface. Mating single pin Packard Weather Pack 
connectors are supplied with the CD-1 to facilitate 
disconnecting the brown wire from the vehicle 
tachometer and connecting it to the USB interface as 
shown in Figures 1 and 2. PC communications is 
possible when the ignition is turned on and the engine 
has not yet been started. Once the engine is started, 
the brown wire resumes its normal function of driving 
the tachometer. Note that no damage occurs if the 
engine is inadvertently started while the USB interface 
is connected. 

After PC Link CD is launched, the main screen 
appears blank. You have three options for obtaining 
setup data for editing. You can open a previously 
saved setup file by using the Open Table command on 
the File menu. You can create a new setup file by 
using (as applicable) the Edit Module Parameters and 
Edit GPIO Parameters commands from the Edit menu 
and the New Timing Table command on the File menu. 
You can also download data from an attached CD-1 
module by using the Download From EEPROM 
command on the Communications menu. 

Note that setup files use a .tbl extension. You 
should create a separate folder to store these files.   

If you have enabled a 2D or 3D timing table 
under module parameters, you can use the Edit Timing 
Table command from the Edit menu. You can edit the 
timing table data by clicking on and dragging individual 
points on the chart display or you can directly edit 
numeric data on the spreadsheet grid.  

Once the appropriate parameters and timing 
table data have been entered, you can print the data 
using the Print Parameters and Timing Table 
command on the Print Menu. You can save the edited 
setup file by using the Save Table command on the 
File menu.  

You can upload the setup data to an attached 
CD-1 module by using the Upload to EEPROM 
command on the Communications menu.   

A setup file (CD1_Sample.tbl) is included in the 
program folder. 

http://www.daytona-twintec.com/
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DOWNLOADING DATA FROM 
EEPROM  

Connect the USB interface. An adapter harness 
is supplied with the USB interface. Connect the 
alligator clip on the black wire to ground and the 
Packard Weather Pack connector to the brown tach 
wire from the CD-1 wire harness. If the tach wire is not 
equipped with a Weather Pack connector, you can use 
the supplied brown jumper wire with an alligator clip to 
make the required connection. Set the switch on the 
USB interface to the "A" position. Turn the ignition 
switch on to provide power to the CD-1.  Do not start 
the engine. 

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the USB interface to use a different 
COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup.  

Download data by using the Download From 
EEPROM command on the Communications menu.  

If the download process is successful, the 
module parameters are displayed. You can then edit 
setup data as explained in subsequent sections.  

CD-1 units are shipped from the factory with 
default parameters and timing tables loaded into 
EEPROM memory. If you have never uploaded any 
custom setup file to EEPROM memory, these defaults 
are what you will see.   

MODULE PARAMETERS  
Module parameters are displayed in a dialog box 

by using the Edit Module Parameters command on the 
Edit menu. Module parameters control the overall 
operation of the CD-1 unit.  

When PC Link CD is first started, default module 
parameters are loaded. Module parameters are 
updated whenever you download data from a CD-1 
unit or open a setup file. Module parameters are saved 
along with the GPIO parameters and timing table data 
when you save a setup file. Always check the 
module parameters before uploading data to the  
CD-1.  

Figure 13 – Module Parameters 

 

http://www.daytona-twintec.com/


 

 
Daytona Sensors, 240 Springview Commerce Dr, Bldg 1 Suite J, Debary FL 32713                       102001/102003 
(386) 322-7390   www.daytona-sensors.com  11/2023 

 Page 21 

General Options 

Disable RPM Limit - all RPM limit functions are 
disabled (including any fixed maximum RPM limit 
selection). 

Disable Multi-Spark - multi-spark is disabled. Multi-
spark should always be disabled when an external 
engine control that generates the trigger signal for the 
CD-1 also limits RPM. Missing trigger pulses could 
cause false multi-spark and result in cross-firing within 
the distributor. 

Disable Timing Functions - all timing functions 
including the automatic start retard and any timing 
table are disabled. 

Fixed Maximum RPM Limit - selecting this option 
overrides all other RPM limit values set on the switches 
and the RPM limit slider and cylinder number select 
options are displayed. However a lower launch or 
burnout RPM limit can still be selected.  

4, 6, or 8 Cylinder Engine - sets the engine type. 8 
cylinder engine is the default. You must select the 
correct engine type for proper scaling of RPM limit and 
timing control functions. Note that when the fixed 
maximum RPM limit is not enabled, cylinder number 
selection is by means of the Mode switch on the CD-1.  

Automatic Start Retard  - selecting this option 
enables the automatic start retard and the start retard 
slider is displayed. You can set a start retard value 
from zero to 10 degrees. The automatic start retard  is 
active for 10 engine revolutions after engine start while 
the engine is running below 450 RPM.   

High Speed Data Logging  - selecting this option 
enables high speed data logging at 100 
samples/second. High speed data logging is 
recommended for all drag race applications. If high 
speed data logging is not enabled, the default data 
logging rate is 10 samples/second.  

Cranking Pulses - the slider sets the number of trigger 
pulses (events) before the CD-1 fires the first spark. 
For a V8 engine, there are 4 trigger pulses per 
revolution. To prevent spurious firing when the ignition 
key is turned on, you should always use a value of 2 or 
higher.   

Retard Comp - the slider allows fine tuning the timing 
to eliminate the effects of spark firing delay and the 
intrinsic delay of some magnetic pickup systems. A 
typical value is 1.5 degrees. Check the timing with a 
timing light. If a noticeable retard is observed between 

2,000 RPM and the upper RPM range of the engine, 
use a higher value for retard compensation.  

Timing Table Options 

Disable Timing Table - no timing table is active. 

2D Timing Table - enables a 2D timing table with 
timing based on engine RPM. 

3D Timing Table - enables a 3D timing table with 
timing based on engine RPM and manifold absolute 
pressure (MAP). The MAP sensor option box appears. 
You can select a 1 bar, 2 bar, or 3 bar MAP sensor. To 
use the 3D timing table, a MAP sensor must be 
connected. Refer to Figure 4 and page 10 for details.  

Note: mode switch settings 3-8 for boost timing 
retard (BTR) mode override and disable any 2D or 
3D timing table selections (refer to the Module 
Switch Setting section on page 12 for details).  

Trigger Timing 

The CD-1 and similar competitive products 
require a trigger signal (magnetic pickup or 12V 
module output) with a single pulse per firing event. The 
rising edge of the trigger pulse is the most advanced 
timing (earliest spark firing) that the unit can generate. 
All timing curves and other timing functions are based 
on delaying the spark firing referenced to the trigger 
pulse. Refer to page 23 for additional information on 
trigger timing. 

Set the Trig (Trigger) Timing slider value to 
correspond to the actual advanced timing point 
(degrees BTDC) of your trigger signal. The trigger 
timing value represents the most advanced timing that 
the CD-1 can generate. The default value is 30 
degrees BTDC, but you must enter the actual value for 
your engine (or adjust your trigger system so that it 
generates a trigger signal at 30 degrees BTDC).  

Timing table data “tracks” the trigger timing 
value. The table values always represent the actual 
engine timing that will result if the trigger system 
generates a pulse corresponding to the trigger timing 
value.  

http://www.daytona-twintec.com/
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GENERAL PURPOSE 
INPUT/OUTPUT PARAMETERS 

General purpose input/output (GPIO) 
parameters are displayed in a dialog box by using the 
Edit GPIO Parameters command on the Edit menu. 
GPIO parameters control the function of the GPI1, 
GPIO2, and GPIO3 terminals on the CD-1 unit.   

When PC Link CD is first started, default GPIO 
parameters are loaded. GPIO parameters are updated 
whenever you download data from a CD-1 unit or open 
a setup file. GPIO parameters are saved along with the 
module parameters and timing table data when you 
save a setup file. Always check the GPIO 
parameters before uploading data to the CD-1. 

Figure 14 – GPIO Parameters 

 

 

General Purpose Input 1 (GPI1) 

GPI1 is on the Deustch connector pin 3.  GPI1 
has five modes: 

Data Log Only - the system will log data on GPI1. You 
can log an analog signal from zero to +5V or a digital 
signal with zero and +12V levels.  

Digital NOS Enable - this mode is used in combination 
with the NOS trigger mode on GPIO2. When GPIO2 is 
configured for NOS trigger mode, the NOS system will 
be triggered on when a +12V level is detected on GPI1 
and all the trigger conditions set for GPIO2 are 
satisfied. You can enter a retard value from zero to 10 
degrees. The retard will be active whenever the NOS 
system is triggered. 

TPS Analog NOS Enable - this mode is used in 
combination with the NOS trigger mode on GPIO2. A 
zero to +5V throttle position sensor (TPS) is connected 
to GPI1. When GPIO2 is configured for NOS trigger 
mode, the NOS system will be triggered on when a 
GPI1 detects a TPS signal greater than the TPS on 
level. If the TPS signal drops below the TPS off level, 
the NOS system will be turned off. This allows some 
hysteresis to prevent cycling the NOS system when the 
throttle position is near the on level. You can enter a 
retard value from zero to 10 degrees. The retard will be 
active whenever the NOS system is triggered. 

Analog Retard - refer to Figure 4 and page 10 for 
details. The optional RTD-1 retard control is connected 
to GPI1, the +5V reference supply on the Deutsch 
connector pin 10, and signal ground on the Deutsch 

http://www.daytona-twintec.com/
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connector pin 9. The RTD-1 can be used to dial in a 
zero to 10 degree retard. Zero volts on GPI1 
corresponds to zero retard and +5V corresponds to 10 
degrees retard. This mode can be used as a driver 
adjustable timing function. 

Digital Retard - you can enter a retard value from zero 
to 10 degrees. The retard will be active whenever a 
+12V signal level is detected on GPI1. This mode can 
be used as high gear retard. 

Note: mode switch settings 3-8 for boost timing 
retard (BTR) mode override any selection for GPI1. 
In BTR mode, the GPI1 is used as an analog input 
for the optional RTD-1 retard control (refer to the  
Switch Setting section on page 12 for details).  

General Purpose Input/Output 2 (GPIO2) 

GPIO2 is on the Deustch connector pin 4.  
When configured as an output, GPIO2 can switch a 2 
amp load to ground. A relay must be used to control 
larger loads, such as solenoid valves. GPIO2 has five 
modes: 

Data Log Only - the system will log data on GPIO2. 
You can log a digital signal with zero and +12V levels.  

Vehicle Speed Input - refer to Figure 9 and page 11 
for details. A Hall Effect type vehicle speed sensor 
(VSS) with 0-5V signal levels is connected to GPIO2. 
Many newer vehicles already have an appropriate VSS 
signal that can be directly connected to GPIO2. For 
correct data logging, the VSS frequency at 60 MPH 
must also be entered.  

Establishing the correct VSS scale factor will require 
some trial and error. Start with the default setting. Log 
speed data while operating the vehicle at a known 
speed. Use CD Log software and download data to 
read the logged speed data. Use the following formula 
to calculate the correct scale factor: 

      New VSS Freq  =  Original VSS Freq x Speed Reading                                 
          Actual Vehicle Speed 

 

For example, if the original VSS frequency parameter 
was 145 Hz, the speed reading is 40 MPH and the 
actual vehicle speed is 50 MPH, then the new VSS 
frequency parameter should be: 

  116 Hz  =  145 Hz x 40 MPH                                 
               50 MPH 

You may have repeat this process several times for 
maximum accuracy. 

Burnout RPM Limit Input - the burnout RPM limit will 
be active and override any launch RPM limit setting or 

higher maximum RPM limit setting whenever a +12V 
signal is detected on GPIO2.  

RPM Window Switch - the GPIO2 output will be active 
(switched to ground) whenever engine RPM is within 
the minimum and maximum values. 

NOS Trigger - the GPIO2 output will be active 
(switched to ground) whenever all the NOS trigger 
conditions are satisfied. NOS trigger conditions include 
any NOS enable mode configured on GPI1, engine 
RPM within the minimum and maximum values, and 
the NOS delay elapsed. If the one-shot delay option is 
not selected, the NOS delay will occur each time the 
NOS system is triggered on. If the one-shot-delay 
option is selected, the NOS delay will only occur the 
first time the NOS system is triggered on after the 
launch input is released. In most drag race 
applications, a one-shot delay is appropriate. 

General Purpose Input/Output 3 (GPIO3) 

GPIO3 is on the Deustch connector pin 5.  
When configured as an output, GPIO3 can switch a 2 
amp load to ground. A relay must be used to control 
larger loads, such as solenoid valves. GPIO3 has four 
modes: 

Data Log Only - the system will log data on GPIO3. 
You can log a digital signal with zero and +12V levels.  

RPM Window Switch - the GPIO3 output will be active 
(switched to ground) whenever engine RPM is within 
the minimum and maximum values. 

Basic Shift Light - the GPIO3 output can directly drive 
a LED type shift light. Refer to Figure 10 and page 11 
for details. The GPIO3 output active will be active 
(switched to ground) and the shift light will come on 
whenever engine RPM exceeds the gear 1 shift RPM 
value.  

Multi-Stage Shift Light - the GPIO3 output can 
directly drive a LED type shift light. Refer to Figure 10 
and page 11 for details. The GPIO3 output active will 
be active (switched to ground) and the shift light will 
come on whenever engine RPM exceeds the selected 
RPM value. Gear detection is based on a signal from a 
line lock solenoid connected to the launch input and 
sensing RPM drop between gears. This mode of 
operation is only suitable for drag racing. The launch 
RPM value is active while the line lock solenoid is 
energized and +12V is applied to the launch input. The 
shift light will illuminate at the launch RPM and start 
rapidly blinking 100 RPM higher. Energizing the line 
lock solenoid also resets the gear counter. When the 
line lock solenoid is released, the launch function is 
disabled and the multi-stage shift light function 
becomes active. You can set individual shift RPM 
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values for up to five gears. If your transmission has 
less than six gears, just set the unused shift points to 
the same value as used for your upper gear. The Short 
Shift Window value provides protection in case you 
shift before the shift point is reached. For the sample 
data shown, the unit would correctly sense a short shift 
from 1st into 2nd gear as low as 5,700 RPM. The 
Minimum Shift Drop value is the minimum RPM drop 
that must occur between gears for the unit to sense a 
shift. 

CREATING A NEW TIMING TABLE 
If you are creating a new setup file, you must 

first select the 2D or 3D timing table option under 
module parameters as explained in the Module 
Parameters section. You can then use the New Timing 
Table command on the File menu. A dialog box 
appears as shown in Figure 15 or 16 depending on the 
type of timing table you selected. 

Figure 15 – New 2D Timing Table Dialog 

 

New 2D Timing Table 

For a new 2D timing table, you can enter the 
trigger timing, start and final RPM, and start and final 
advance. A new value of trigger timing overrides and 
updates whatever value you may have previously 
entered under module parameters. Set the trigger 
timing value to correspond to the actual advanced 
timing point (degrees BTDC) of your trigger signal. The 
trigger timing value represents the most advanced 
timing that the CD-1 can generate. The default value is 
30 degrees BTDC, but you must enter the actual value 
for your engine (or adjust your trigger system so that it 
generates a trigger signal at 30 degrees BTDC). 
Trigger timing is shown on the graph as a straight blue 
line. The actual timing advance curve is shown in red. 
Since trigger timing represents the most advanced 
timing, the red timing curve can never go above the 
blue trigger timing line. The total timing range of the 
CD-1 is limited to 22 degrees to prevent possible 
crossfiring into the next cylinder. For example, if you 

set trigger timing to 30 degrees, the actual advance 
range is 8.0 to 30 degrees. The program will not allow 
you to enter values outside this range. 

Each time you click on Update, the 
corresponding timing advance table is displayed. You 
will find the New Timing Table command useful for 
generating a timing advance table that will serve as a 
starting point for further edits. When you are ready to 
proceed with editing, click on OK. 

Figure 16 – New 3D Timing Table Dialog 

 

New 3D Timing Table 

For a new 3D timing table, you can enter the 
trigger timing and a base timing value. The base timing 
value is used to generate a flat timing table. A new 
value of trigger timing overrides and updates whatever 
value you may have previously entered under module 
parameters. Set the trigger timing slider to correspond 
to the actual advanced timing point (degrees BTDC) of 
your trigger signal. The trigger timing value represents 
the most advanced timing that the CD-1 can generate. 
The default value is 30 degrees BTDC, but you must 
enter the actual value for your engine (or adjust your 
trigger system so that it generates a trigger signal at 30 
degrees BTDC). Since trigger timing represents the 
most advanced timing, the 3D timing table values can 
never exceed the trigger timing. The total timing range 
of the CD-1 is limited to 22 degrees to prevent possible 
crossfiring into the next cylinder. For example, if you 
set trigger timing to 30 degrees, the actual advance 
range is 8.0 to 30 degrees. The program will not allow 
you to enter values outside this range. 

Each time you click on Update, the 
corresponding timing advance table is displayed. You 
will find the New Timing Table command useful for 
generating a timing advance table that will serve as a 
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starting point for further edits. When you are ready to 
proceed with editing, click on OK. 

EDITING TIMING TABLE DATA 
Once you have timing advance table data, you 

can edit the data by clicking on and dragging individual 
points on the chart display or you can directly edit 
numeric data on the spreadsheet grid.  

2D Timing Table 

The table consists of 21 columns corresponding 
to 500 RPM increments from zero to 10,000 RPM. The 
10,000 RPM timing value is used at all higher RPM 
levels.  

The trigger timing value represents the most 
advanced timing that the CD-1 can generate. The 
default value is 30 degrees BTDC, but you must use 
the actual value for your engine (or adjust your trigger 
system so that it generates a trigger signal at 30 

degrees BTDC). If you need to change the trigger 
timing value, go back to module parameters. Trigger 
timing is shown on the graph as a straight blue line. 
The actual timing advance curve is shown in red. Since 
trigger timing represents the most advanced timing, the 
red timing curve can never go above the blue trigger 
timing line. The total timing range of the CD-1 is limited 
to 22 degrees to prevent possible crossfiring into the 
next cylinder. For example, if you set trigger timing to 
30 degrees, the actual advance range is 8.0 to 30 
degrees. The program will not allow you to enter 
values outside this range. 

There is a slight signal delay within the CD-1 
unit. This affects the maximum advance that can be 
generated at high RPM. You should leave about 1 
degree headroom between the maximum advance 
value on your table and the reference (trigger) timing 
value. For example, if your reference timing is 30 
degrees, you should not use timing table values 
exceeding 29 degrees above 3,000 RPM. 

Figure 17 – 2D Timing Table 

 

PC Link CD is intended to be an open system 
and uses the Component One Chart 7.0 2D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 

Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link CD. 
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3D Timing Table 

The 3D timing advance table consists of 21 
columns corresponding to 500 RPM increments from 
zero to 10,000 RPM and 8 manifold pressure (MAP) 
rows. The MAP range depends on the type of MAP 
sensor selected under module parameters. The timing 
value at 10,000 RPM is used at all higher RPM levels 
and the timing value in the lowest MAP row is used at 
all lower MAP levels. Note that 30 In-Hg corresponds 
to atmospheric pressure (zero boost). Normally 
aspirated engines will not exceed 30 In-Hg and not all 
supercharged engines will reach the maximum MAP 
level for 2 bar or 3 bar MAP sensors. You can use the 
CD Log software to check the actual MAP values when 
the engine is running under various load and throttle 
settings.  

The trigger timing value represents the most 
advanced timing that the CD-1 can generate. The 
default value is 30 degrees BTDC, but you must use 

the actual value for your engine (or adjust your trigger 
system so that it generates a trigger signal at 30 
degrees BTDC). If you need to change the trigger 
timing value, go back to module parameters. Since 
trigger timing represents the most advanced timing, the 
3D timing table values can never go exceed the trigger 
timing. The total timing range of the CD-1 is limited to 
22 degrees to prevent possible crossfiring into the next 
cylinder. For example, if you set trigger timing to 30 
degrees, the actual advance range is 8.0 to 30 
degrees. The program will not allow you to enter 
values outside this range. 

There is a slight signal delay within the CD-1 
unit. This affects the maximum advance that can be 
generated at high RPM. You should leave about 1 
degree headroom between the maximum advance 
value on your table and the reference (trigger) timing 
value. For example, if your reference timing is 30 
degrees, you should not use timing table values 
exceeding 29 degrees above 3,000 RPM.    

Figure 18 – 3D Timing Table 
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You can rotate the 3D chart display for a better 
view of a particular region by dragging the mouse while 
holding both mouse buttons down. PC Link CD is 
intended to be an open system and uses the 
Component One Chart 7.0 3D charting control. The 
adventurous user can experiment with the chart 
property pages by right clicking on the chart. Almost 
any chart property can be changed. Click on the Help 
button for more information. If you corrupt the chart, 
exit and restart PC Link CD.  

Editing Spreadsheet Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
the left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command.   

Figure 19 – Modify Command 

 

Data Export and Import by Means of Copy 
and Paste 

You might want to export or import table data to 
or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link CD program. In the PC Link 
CD program, you can select a range of cells with the 
mouse and right click to bring up a copy and paste 
menu. When you paste data into the PC Link CD 
program, the data is automatically checked and any 
out-of-range data corrected. 

UPLOADING DATA TO EEPROM 
Refer to the Downloading Data from EEPROM 

section on page 16 for details about USB interface 
cable hookup and COM port setup. Before uploading, 
make sure the parameters and timing tables are 
correct.  

Upload data by using the Upload To EEPROM 
command on the Communications menu. A status 
message is displayed when the upload process has 
been successfully completed. 

TRIGGER TIMING 
CONSIDERATIONS 

Refer to Figure 20. The trigger timing value set 
under module parameters must correspond to the 
actual timing point (degrees BTDC) of your trigger 
signal. The trigger signal can come from a magnetic 
pickup crankshaft position sensor, magnetic distributor 
pickup, or 12V module trigger signal from another 
system such as an electronic engine control module 
(ECM). The trigger timing value represents the most 
advanced timing that the CD-1 can generate. The 
default value is 30 degrees BTDC, but you must enter 
the actual value for your engine (or adjust your trigger 
system so that it generates a trigger signal at 30 
degrees BTDC). Since trigger timing represents the 
most advanced timing, the timing table values can 
never exceed the trigger timing. The total timing range 
of the CD-1 is limited to 22 degrees to prevent possible 
cross firing into the next cylinder. For example, if you 
set trigger timing to 30 degrees, the actual advance 
range is 8.0 to 30 degrees (shaded area in Figure 20). 

The trigger timing value is also used by the CD 
Log data logging software to allow correct display of 
timing advance.  

Figure 20 – Trigger Timing 
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Magnetic Pickup Crankshaft Position 
(CKP) Sensor 

You can accurately establish the position of the 
CKP sensor by temporarily disabling multi-spark and 
any timing table in module parameters (remember to 
upload to CD-1). Use a timing light to check the timing 
and adjust the position of the CKP sensor as required 
so that your observed engine timing is the same as the 
trigger timing value. For best accuracy, we suggest 
that you set the timing at 1,500-2,000 RPM. While you 
are conducting this test, you should also check the 
distributor phasing. Use a spare distributor cap and drill 
or mill a large hole on the top or side so that you can 
observe the rotor tip position at cylinder 1 with the 
timing light. If you are using a dial-back timing light, set 
the dial-back to zero while observing rotor tip position. 
The leading edge of the rotor should just touch the cap 
terminal.  

 

 

 

Magnetic Pickup Distributor without 
Advance Mechanism 

You can accurately establish the position of the 
distributor by temporarily disabling multi-spark and any 
timing table in module parameters (remember to 
upload to CD-1). Use a timing light to check the timing 
and adjust the position of the distributor as required so 
that your observed engine timing is the same as the 
trigger timing value. For best accuracy, we suggest 
that you set the timing at 1,500-2,000 RPM.  

Magnetic Pickup Distributor with Advance 
Mechanism 

In this case, you will not be using a timing table, 
but you might still want to use the retard features and 
data logging. Set the trigger timing value to correspond 
to the maximum distributor advance at high RPM.  

Module Trigger from an ECM  

In this case, you will not be using a timing table, 
but you might still want to use the retard features and 
data logging. Set the trigger timing value to correspond 
to the maximum advance generated by the ECM at 
high RPM. 
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CD LOG SOFTWARE 
The brown tachometer wire (Deutsch connector 

pin 11) from the CD-1 is used connect to the USB 
interface. Mating single pin Packard Weather Pack 
connectors are supplied with the CD-1 to facilitate 
disconnecting the brown wire from the vehicle 
tachometer and connecting it to the USB interface as 
shown in Figures 1 and 2. PC communications is 
possible when the ignition is turned on and the engine 
has not yet been started. Once the engine is started, 
the brown wire resumes its normal function of driving 
the tachometer. Note that no damage occurs if the 
engine is inadvertently started while the USB interface 
is connected. 

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the USB interface to use a different 
COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup.  

After CD Log is launched, the screen initially 
appears blank. You can use the Units Selection 
command from the Edit menu to select speed and 
pressure units if your CD-1 is configured to log this 
data, i.e. vehicle speed sensor and/or manifold 
absolute pressure (MAP) sensor connected. The 
program will remember your selections. You can 
display data logged by the unit on a chart recorder type 
screen. Data logged by the unit must be downloaded 
before it can be displayed, by using the Download Data 
command on the Communications menu. Once data 
has been downloaded, it is automatically displayed on 
a chart recorder type screen. You can save 
downloaded data by using the Save File command 
from the File menu. You can display a previously 
saved data file by first using the Open File command 
on the File menu and then using the View Chart 
command on the View menu. 

A sample data file (CD1_Sample.log) is included 
in the program folder. 

UNITS SELECTION 
You can use the Units Selection command from 

the Edit menu to select speed and pressure units if 
your CD-1 is configured to log this data, i.e. vehicle 
speed sensor and/or manifold absolute pressure 
(MAP) sensor connected. The program will remember 
your selections. When you save downloaded data to a 
file, the units settings are saved along with the data. If 
you later open the file, the same units settings will 
remain in effect. 

Figure 21 – Units Selection Dialog Box 

 

DOWNLOADING DATA 
Connect the USB interface. An adapter harness 

is supplied with the USB interface. Connect the 
alligator clip on the black wire to ground and the 
Packard Weather Pack connector to the brown tach 
wire from the CD-1 wire harness. If the tach wire is not 
equipped with a Weather Pack connector, you can use 
the supplied brown jumper wire with an alligator clip to 
make the required connection. Set the switch on the 
USB interface to the "A" position. Turn the ignition 
switch on to provide power to the CD-1.  Do not start 
the engine. 

When launched for the first time, the program 
uses COM1 as the default port. In most cases, you will 
have configured the USB interface to use a different 
COM port, such as COM5. Use the Port Setup 
command on the Communications menu to select the 
correct COM port. The program will remember the new 
port setup.  

Download data by using the Download Data 
command on the Communications menu. 

DATA LOGGING CHART DISPLAY 
You can display data logged by the unit on a chart 
recorder type screen. Data logged by the unit must be 
downloaded before it can be displayed, by using the 
Download Data command on the Communications 
menu. Once data has been downloaded, it is 
automatically displayed. The last data logged will 
appear at the right end of the chart. You can save 
the data by using the Save File command from the File 
menu after closing the chart display (data is not lost by 
closing the chart display). You can display a previously 
saved data file by first using the Open File command 
on the File menu and then using the View Chart 
command on the View menu. 

The data logging memory within the CD-1 stores 
the last 18000 data points at 10 samples/second 
(default sample rate) or 100 samples/second (if the 
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high speed data logging mode is selected by means of 
the PC Link CD software). This corresponds to 5 hours 
of data at 10 samples/second or 30 minutes of data at 
100 samples/sec. When you use the Download Data 
command on the Communications menu, one of the 
popup menus shown below will appear based on the 
sampling rate you have configured. You can select the 
length of the data set that will be downloaded.  

Figure 22 – Download Options Dialog Box 
(CD-1 Configured for 10 Samples/Second) 

 

Figure 23 – Download Options Dialog Box 
(CD-1 Configured for 100 Samples/Second) 

 

Note that CD-1 data files use a .log extension. 
You should create a separate folder to store these 
files. A sample data file (Sample.log) is included in the 
program folder.    

You have a range of capabilities for analyzing 
downloaded data displayed in the chart recorder 
format. 

You can select two parameters for display. 
Trace 1 is displayed in red with its Y axis legends on 
the left side of the chart. Trace 2 is displayed in green 
with its Y axis legends on the right side of the chart. 
The X axis is always elapsed time. You can zoom in, 
zoom out, or zoom all (displays entire data file). At the 
maximum zoom in level, approximately 100 data 
samples will be displayed on the chart. You can use 
the scroll bar to move the chart display window in 

terms of elapsed time. If you hold the left mouse button 
down within the chart area, a cursor line appears. The 
exact values of the parameters displayed on trace 1 
and trace 2 and the elapsed time appear in windows 
above the chart. When you zoom in or zoom out, the 
displayed data will always be centered about the 
cursor line. This allows you to quickly select and 
closely examine an area of interest. If you want to 
analyze the elapsed time between two events (for 
example the time required to accelerate from 0 to 60 
MPH), you can move the cursor to the first event and 
then click on the Reset Time Display button. You can 
print the displayed chart to any Windows printer by 
clicking on the Print button (a color inkjet printer is 
recommended for best results). Data parameters 
include: 

RPM – engine crankshaft RPM 

TIMING – ignition advance in degrees BTDC 

MAP – manifold pressure in In-Hg, kilopascals (kPa), 
or psi (29.92 In-Hg, 101.3 kPa, or 14.696 psi 
corresponds to sea level atmospheric pressure). If a 
MAP sensor is not connected, the MAP value 
corresponding to zero sensor volts will be displayed. 
The CD-1 supports standard Delphi 1 bar, 2 bar, and 3 
bar MAP sensor as configured with the PC Link CD 
software. 

VSS – vehicle speed in MPH or KPH. If a vehicle 
speed sensor is not connected, a zero value will be 
displayed. 

BAT – battery voltage 

GPI1 ANALOG – zero to +5V analog input voltage on 
the GPI1 input (Deutsch connector pin 3) 

LAUNCH – input level on Deutsch connector pin 2 
displayed as a digital (on/off) signal  

GPI1 DIGITAL – input level on the GPI1 terminal 
displayed as a digital (on/off) signal. On means that the 
GPIO is terminal is at +12V  

GPIO2, GPIO3 – these terminals (GPIO2 on Deutsch 
connector pin 4 and GPIO3 on pin 5) can be 
configured as inputs or outputs for various functions 
with the PC Link CD software. When configured as an 
input, the level is displayed as a digital (on/off) signal. 
On means that the GPIO terminal is at +12V. When 
configured as output, the status is also displayed as a 
digital (on/off) signal. On means that the GPIO terminal 
is switched to ground. This is referred to as an active 
low output  
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The maximum RPM and VSS values displayed 
on the chart can be set by means of commands on the 
Chart Display Edit Menu. Caution: If these maximum 
values are set lower than the actual logged data, 
the chart cursor function will not update the 
display correctly.  

Additional data is displayed at the lower right 
side of the screen. This data includes: 

Status - displays CD-1 status  

Diagnostic Code – normally blank unless a diagnostic 
code is set.  

Log Interval – the actual data logging interval in 
seconds 

You can clear the data within the unit by using 
the Clear CD-1 Data Buffer command from the 
Communications menu. If you change the data logging 
mode with the PC Link CD software, you should also 
clear the data buffer within the unit. 

 

Figure 24 – Data Logging Chart Display 

IMPORTING DATA INTO EXCEL 
Data files saved from CD Log are in comma 

delimited ASCII format. Note that VSS data is scaled in 
MPH units and MAP data is scaled in In-Hg units. You 
can easily import a data file into other programs such 
as Microsoft Excel for further analysis. You can also 
view data files with a text editor such as Windows 
WordPad. To import a data file into Excel: 

1. Start Excel. In the File Open dialog box, select 
Files of type: All Files (*.*). Then browse for the 
data file. 

2. The Text Import Wizard appears. For step 1, select 
delimited file type. For step 2, select comma 
delimiter. For step 3, select general column data 
format. Then click on Finish. 

3. You can then format the data and save the 
spreadsheet as an Excel file. 
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APPENDIX – RECOMMENDED 
PARTS AND SUPPLIERS 

MAP SENSORS 
To connect a Delphi MAP sensor for boost 

timing retard mode or for implementing a 3D timing 
table, you will have to fabricate a wiring harness with 
the appropriate mating connector or use our MAP 
sensor harness kit P/N 102006. Recommended Delphi 
MAP sensors, and equivalent aftermarket parts are 
listed in the table below. Note that Wells is stocked by 
Autozone (www.autozone.com) and SMP (Standard 
Motor Products) is stocked by RockAuto 
(www.rockauto.com). 

Range Delphi P/N Aftermarket P/Ns 

1 bar 
(normally 
aspirated 
engines)  

12219927, 
16254719, 
16175339, 
12247561 

Wells SU105 

SMP AS165 

2 bar (0-15 
psi boost) 

16009886 
Wells SU129 

SMP AS4 

3 bar (0-30 
psi boost) 

12223861 
Wells SU504 

SMP AS210 

WIRE 

Wire supplied with most automotive accessories 
is usually un-tinned copper with a low number of 
strands. The unprotected copper in this inexpensive 
wire quickly oxidizes, especially when in contact with 
dissimilar metals on terminals. The low number of 
strands limits life in applications where flexing occurs. 
We recommend the use of high quality industrial grade 
wire with tinned copper strands and a high strand 
count.   

18-20 AWG sizes can be used for all signal and 
low current applications. 16-18 AWG is adequate for 
line lock and trans brake solenoid wiring. 14 AWG 
should be used for high current fuel and nitrous 
solenoid wiring. Carol UL grade 1007/1015 wire is 
available from Digi-Key. 

P/N   Description 

C2040X-100  20 AWG wire (100 foot spool) 

C2064X-100  18 AWG wire (100 foot spool) 

C2104X-100  16 AWG wire (100 foot spool) 

C2105X-100  14 AWG wire (100 foot spool) 

Note: replace X with color code B=Black, 
W=White, R=Red, G=Green, A=Orange, 
Y=Yellow, L=Blue, N=Brown, S=Gray,  
V=Violet 

CRIMP TERMINALS 

High quality crimp terminals and a proper 
crimping tool are required to make reliable electrical 
connections. Crimp terminals commonly sold in 
automotive and hardware stores have brittle vinyl 
insulation that easily cracks. We recommend the use of 
high quality industrial grade nylon insulated crimp 
terminals. The following parts are available from Digi-
Key.       

P/N  Description 

A27241  16-20 AWG #10 ring tongue terminal 

A27246  16-20 AWG 1/4” ring tongue terminal 

A27248  16-20 AWG 3/8” ring tongue terminal 

A27262  14-16 AWG 1/4” ring tongue terminal 

A27264  14-16 AWG 3/8” ring tongue terminal 

A27288  10-12 AWG 1/4” ring tongue terminal 

A27291  10-12 AWG 3/8” ring tongue terminal 

A0911  18-22 AWG .110” female quick  
  disconnect terminal 

MNU18-187DFIK 18-22 AWG .187” female quick 
   disconnect terminal 

MNU18-250DFIK 18-22 AWG 1/4” female quick 
   disconnect terminal 

MNU14-250DFIK 14-16 AWG 1/4” female quick 
   disconnect terminal 

A1069  16-22 AWG butt splice 

A1080  14-16 AWG butt splice 

A1086  10-12 AWG butt splice 

RELAYS 

The typical import brand 30-40 amp relays leave 
little safety margin. When used to switch heavy 
inductive solenoid loads, arcing can result in the 
contacts welding together – a potentially catastrophic 
failure mode. We recommend using Tyco/P&B 
automotive OE grade relays available from Newark 
Electronics and Digi-Key. Use the 40 amp version for 
most applications and the 70 amp version for 
fuel/nitrous solenoid activation. We recommend that 
you use the relay sockets and crimp terminals listed 
along with the relays.  

P/N  Description 

1432791-1 40 amp VF4 series relay 

VCF4-1001 Socket for VF4 series relay 
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60249-1 12-16 AWG terminal for VF4 

VF7-41F11 70 amp VF7 series relay 

VCF7-1000 Socket for VF7 series relay 

42281-1 14-18 AWG terminal for VF4 coil
  connections (2 required) 

280756-4 10-14 AWG terminal for VF7 
  contact connections (2 required) 

FUSES AND FUSE TAPS 

ATC series fuses and fuse holders commonly 
used for automotive applications are only available in 
40 amp and lower ratings. For high current 
applications, we recommend the heavy duty 50 amp 
Littlefuse Maxi Fuse series available from Digi-Key.     

P/N  Description 

F1085  Maxi fuse block 

F1038  50 amp Maxi fuse 

 

SWITCHES 

All switches used in performance applications 
should be sealed. Representative sealed toggle and 
rocker style switches available from Digi-Key are listed 
below.     

P/N  Description 

480-2191 Honeywell SPDT toggle switch 

360-2278 NKK SPDT rocker switch 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RELIABLE CONNECTIONS TO EXISTING 
SIGNALS 

For some applications, you may have to tap into 
existing signal wires on the vehicle. We caution against 
using any of the so called “vampire clips” that make an 
insulation displacement connection. These have 
proven very unreliable in racing applications. They may 
even cause the original wire to fray and break. We 
suggest soldering any connections to existing signals. 
Use a stripping tool to cut through and push back 
about 1/4” of insulation at the spot on the original wire 
where you plan to make the connection. Wrap several 
turns of the new wire around, solder, insulate with self 
vulcanizing electrical tape, and use two cable ties to 
secure the splice as shown. Regular electrical tape will 
tend to unravel. Self vulcanizing electrical tape is 
available from Digi-Key as their P/N W213.    

 

SUPPLIERS 

Suppliers referenced in the Appendix are listed 
in the table below. Additional suppliers for connectors, 
electronic tools, mechanical hardware, and test 
equipment are listed on our website at     
www.daytona-sensors.com/tech_tools.htm. 

 

Supplier Phone Website 

Digi-Key 1-800-344-4539 www.digi-key.com 

Mouser 1-800-346-6873 www.mouser.com 

Newark 1-800-463-9275 www.newarkinone.com 

State Wire 
& Terminal 

1-800-922-6527 www.statewire.com 

http://www.daytona-twintec.com/
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